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Note: This product is distributed on a ‘try-before-you-buy’ basis. All features described in this
documentation are enabled. The unregistered version will be added a demo watermark.

About EPUB TO FLIPBOOK

If you want to show your EPUB in a fresh and popular way, converting EPUB to Page-flipping
eBooks could be a good choice.

Flip books, no longer simple illustrated books for children, but also refer to the e-books which
combine page-flipping effect with electronic technology. This brand new publishing mode is
changing the way how the 'common' people will receive and view information. Normally by just
clicking the page on your computer screen, then you can flip and read the pages as reading real
ones. It looks really innovative and you can use it for your presentation.

And program EPUB TO FLIPBOOK is powerful enough to convert your EPUB to such kind of eBooks
with ease.

EPUB TO FLIPBOOK is flexible software to convert EPUB to stunning page-flipping eBooks. The
program can be used for all levels of users without any programming knowledge needed. It will
perfectly integrate your EPUB book with life-like page turning effect into a new look eBook to be
published, emailed, stored as standalone EXE format or even with burned to CD.

With using EPUB TO FLIPBOOK, you can build your style eBooks using the dozens of preset
templates and adjust more than 50 kinds of settings yourself. You are able to use your favorite
background images, sounds, titles, exe logos, you can control book size, font, font and tool bar
buttons, you can even choose a hard or soft cover, right to left flipping and auto flipping to
present your EPUB in an interactive way.

After designing style for your page-flipping eBooks, you can choose a proper way to output:
"HTML" is for publishing online, "ZIP" can be much easier for emailing, "EXE" is an intergraded
format for quickly viewing, "Burn to CD" to output your digital books directly on CD-ROM.
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Detail features:

® Convert EPUB to page-flipping eBooks.
® OQutputin 4 different formats: HTML, EXE, Zip and Burn to CD.
HTML allows you to upload to a website to be viewed online.
EXE and Zip allow you to send to your user by email to be viewed on their computer.
Burn to CD allows you to burn to disk so you can send out with physical media.
® Make a Mobile Version at the same time.
® Define your language for flash.
® Preview the output effect instantly.
® Provide multiple templates (default provided or download from website).
® Select render engine to output higher quality page-flipping ebook.
® Define mobile version quality.
® Import text so that text is searchable, define the minimum search characters.
® Set eBook size, choose landscape or portrait.
® Add password to protect your page-flipping eBook.
® Define titles, keywords and other metadata.
® Add Google Analytics Support.
® Define titles, icon, window size for EXE page-flipping eBooks.
® Define eBook margin size.

® Insert background music either for continuous play (loop) or for a set duration.

® Set background color and image.
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® Set eBook reading from right to left (for Right-to-Left languages such as Arabic).
® Choose hard cover for eBooks.

® Set page-flipping to manual or automatic.

® Set permissions for downloading, printing, sharing, Home button and more.

® Set colors and position (Top/Bottom) for toolbar.

® Set scale for zoom-in function.

® Set control bars to "show" or "hide" in full screen.

® Set the bookmark panel to show on left or right side.

® Set links to open in same or new window.

® Save and Load your project.

® Export and save settings for future use.

Using EPUB TO FLIPBOOK

1]
A
EPUB TO FLIPBOOK can be started either by launching the application via the desktop short cut , or
directly from Windows Explorer. Start the program, you will see the below initial window:
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The file in the processing interface is an example file.

There are some main interfaces you will see while using EPUB TO FLIPBOOK as below shows: Application
Options, Import EPUB Document, Template Settings, Language Option and Output. You can enter into
each page to get clear instructions for every detail option.

I. Application Options Interface

1. Render Engine Option

EPUB TO FLIPBOOK provides 3 different render engines for you to create higher quality page-
flipping eBooks, click "Options->Application Options" to enter into "Render Engine" interface:
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o b
Render Engine | Create Mobile Version |

Flease selecte a render engine for the conversion

[SWF
@ SWF
F
[ 55
(1 GPL Ghostscript  Dowload Ghostscript
F
[ LI |

(70 Inner Library
r

SWF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality

Inner Library: Faster convert speed

[ ok | [ conl

SWF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality
Inner Library: Faster convert speed

(Change option when EPUB imported failed)

2. Create Mobile Version Option

Five types of "Quality And Size":

Pages Quality and Size

Quality And Size:

High quality large file size
Medium quality medium file size
Low quality small file size
Lower quality smaller file size

High values ¢
A but require m
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Il. Import EPUB Interface:

,
I import EPUB =

Source EPUE Flie
E:\sample, epubl| Browse,, | | Oper it I
The Page Ranges to Import Watermark
@) All pages Ll Place a custom text or image
() Custom range: Example:1,3,5,9-21 ! "9: Watermark(Stamp) to the file(s)
[7] Quiddy impert (Only import 10 pages to initial preview) Set Watermark
Page Quality
Quality And Size; [I—hgh quality large file size v]
4% High values produce better page quality but require more disk space and mare time to download.
|
[¥] tmpart bookmark [¥] mpart links [T]Enable search
Import Now Cancel I

Panel Description:

1. Source EPUB File

Click this icon to open the EPUB file you want to convert;
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Open it

View content of added EPUB file to clarify before converting.

2. The Page Ranges to Import

@ Al pages
Convert all pages to page-flipping eBooks;

@) Customn range:  2-5 Example:1,3,5,9-21
Convert a range pages to eBook;

[ Quickly impart {Only impart 10 pages to initial preview) . . .
Preview applied effect on first 10.

3. Watermark

l@] Add image or text watermark to flipping pages.

& ing W 5 . —
(¥} Applying Watermark Check this option first to choose default stamps or add new ones:
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1) 2 Text wotermarte =]
% Add Text Watermark
Text Nome

Name:  Text Watemar

Teal:  Page-fipong ook Mot -

TestPropeses

Eant: @ petvesca. =] [7lEmbeaded pant

P o I 1

Stie: [Finod I trab: Il urderion

Text Ly

Laveust: [Fix, - [ s bacground
TigStrle

Page-tlipping eBook

@)

Edit / f :
Jatic Loite
Add text stamp e =

Add image stamp. Jli)aimsge Watermss

Delete Image name

Move down R [

D ¢ X # ¥

Move up Thon et

4. Page Quality

There are five types of "Quality And Size":

Medium quality medium file size
Low guality small file size
Lower guality smaller file size

5. Other Options

[ tmport bookmark . . . . . o
If your EPUB file contains bookmarks, check this option to use in output page-flipping

eBook;

Import links If your EPUB file has links, check this to enable in flipbook;
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] Enabl ch . . . I .
£ b e Check this option to enable search functionality in created flipbook.

At last, click

icon to enter into template setting interface.

lll. Template Settings Interface:

f : ~
| select a Template .. l =10 ﬂ
Choose & flipbook template here, (Double-dick to make a quick selection)
B8 | (More and more templates will be provided in future.)
I Get More Themes Online
Templates il

El Classical
T Float

! Spread

m

Blank Blues Colorful

D azzle Flarid Flany-red

-

] o= |

The program provides three different templates at present: Classical, Float and Spread.
Each template contains some unique settings, the below instructions will show you details.
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The design setting interface contains below main parts:
Choose Template

Book

Sound

Tool Bar

Initial Show

Bookmark

Language

Security Settings

Panel Description:
1. Choose Template
Templates

‘ ECIassical H

Please customize the flash template here

m Classical t

Click

icon to select templates from below interface:
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r@m. e L‘—."’.‘ﬁ“

hoose 8 fipbook kemplsde here. [Double-chol fo ke & quick’ sebecbon]
M| More snd s teplates ol B proviced i fuiuee.)

|}

| Tempiates
IEDan:.ll
| EE Foet

2 Sormad

| = Th = = .
(=] o] Gl |

o = = — p———— — — —— = — e —-=

Click this icon is to save current settings as a TXT file for later uses;

2. Book Panel
ElBock

Click this icon is to import stored setting file at once.

_ HideBookFrameBar  No
...Retain the book to center (N0
"_B Proportions

_ BotomMargn 1
__Right Margin a0

_Page Background Color | IO

Flipping Time 0.6
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(1) Book Title (only can be set in Float Template)

Customize book title for showing on the top of your flipbook.

(2) Hide Book Frame Bar
| Hide Book Frame Bar |fes |

If don’t want to show the book frame bar, choose “Yes” in this option.

(3) Retain the book to center

| Retain the book to center [Yes Rd |

If you select “No” in this option, the eBook will be shown on the right-side. This setting is for embedding
special background image, such as advertisement or company log.

(4) Book Proportions

" EfBack Propor tons |
Bage Width 55 |
Page Height B42 |
--— Width

Please note that the values are not fixed in pixels or inches, they just represent a ratio for "Page Width:
Page Height", and the book size will be changed depend on your Explorer Window Size.
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(5) Book Margin

A. Book Margin (set in Classical Template):

"Book Margin" refers to the distance between the book and the toolbar.

B. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):

| Top Margin 0

| Bottom Margin 0

| Left Margin 60

| RihtMargin |50
Top_1

~) Bottom o

(6) Flash Window Color

| Flash Window Color | O

This color will be applied on all flash windows, such as the book window, "Help" window, "Print" window
and so on.
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(7) Page Background quor

with the "Page Background Color".

(8) Page Shadow

T ; -
Left page Shadow | 100 |
Right page Shadow |55 |
Page Shadow Opacity |1

|Left page Shadow

| g

| Right page Shadow|
The value also takes the value of Book Proportions as reference, and the value interval of "Page Shadow
Opacity" is "0~1", the larger value refers to the deeper shadow color.

(9) Background Config
A. Background Color:

BBackground Color
Gradient Color A T
Gradient Color B B0x408...
Gradent 20

,Gradient Color A

Gradient Color B
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Define background for your flipbook with gradient color or pure color (the same color for "Gradient Color
A" and "Gradient Color B"). Gradient Angle is the angle between the two colors.

B. Bac_kground Image setting in Classical and Spread templates:

Click the icon "==I" to choose background image from your computer, and there are 11 kinds of "Image
Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center,
Middle Right, Bottom Left, Bottom Center and Bottom Right.

C. Background Image setting in Float template:
- ;

The Float template enables you to add two background images: Outer Image and Inner Image. You can make
Inner background image to show special information, such as advertisement or company logo, etc. There
are also 11 kinds of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right,
Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

(10) Right to Left
If the language of your file is read from right to left (such as Arabic), then choose "Yes" in "Right to Left"
option:

Right To Left Yes
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(11) Hard Cover
If you want create hard cover effect (a book bound with rigid protective covers) for your flipbook, choose
"Yes" in "Hard Cover" option:

-_ Hard Cover |Yes

(12) Flipping time
Sets page flipping time in seconds according to your needs. (Recommended second value is 0.6):
Flipping Time 0.8

3. Sound Panel

ESound
Enable Sound |Enable |
I Sound File ipie3.mp |
Sound Loops -1

If you want to add background sound to your flipbook, such as a song or other audio file, set "Enable
Sound->Enable", then click "=]" icon to choose "Sound File" from your computer, then set "Sound Loops",
"-1" stands for playing the sound file all the time while viewing flipbook, other value (N>0) stands for the
times of playing the sound file.
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4. Tool Bar
HTeolBar o ]
Icon Color . (LIoxfFFF |
HZoomConfig 1
~ PrintEnable |Yfes |
~ Search Button ~ [Hide

 leastsearch characters |3 |
HDownload setting

Search Hi.gll'lﬁghj: C-cnlur.- 'Mlox408080 |

Full ScreenButton ~ |Show |

HelpButton  IShow |
MShareButton 1]
BHome Button ]
=

ToolBarontop ~ |False

Page Mumber Box COn B... False

(1) Tool bar (only in Classical Template)
Tool bar |Shaw | Show or Hide Tool bar in created flipbook.

(2) Icon Color

Icon Color | awFrrr =]
i e = ~ = @
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(3) Zoom Config

To enable Zoon In functionality, choose 'Yes" in "Zoon in enable", you can set "Zoom Scale" in Classical
Template, the value is the times between zoomed page size and the current page size.

(4) Print Enable
Print Enable Yes

Choose "Yes" in "Print Enable", then click icon to set print page range as below:

& Print w

= Print &0 Pages
_ Print Current Page

/) Prnt Range
Example; 2. 5,8-26

£ Print

(5) Search Button:
| Search Button |Show
....Search Highlight Color | Bl0x408080 |
Lesst search characters |3
Select "Show" in "Search Button" (make sure you have check "Enable Search" option in "Import EPUB"

interface), then define "Search Highlight Color" and "Least search characters", after clicking "Search" icon
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, you will see a popup box to input search words, then click Enter or "Search" button, you will get the
below searching result:

wrm | e s Pag=L _ i

— b

T b R S, e e

T N —
{ e g S b =
A S ——

(6) Download setting:

ElDownload stiing
Download Enable Yes
| Download URL PPTDemo.ppf

If you want your flipbook readers to download the EPUB file or the flipbook directly from your website,
select "Yes" in "Download Enable" option, then input the Download URL directly, you can use absolute path
like "http://www.flippagemaker.com/FLIPBOOK-Word/example/files/download/FlipWORDDemo.doc" or
relative path like "/files/download/Flip®WWORDDemo.doc" (make sure you have uploaded the WORD file to
the same path).

Then readers can click the icon E to download your uploaded EPUB file directly.

(7) Full Screen

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen Button" option:
Full Screen Button |shaw

I = . . . - e .

Then you can click icon -to view flipbook in Full Screen, click icon E or "Esc" button to exit from
the Full Screen.

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode, you can set "No"

in "Full Screen without Tool Bar" (just in Classical Template): .. Ful Screen Without Tool.. | Yes
(8) Help Button

To show tips about viewing flipbook, you can set "Show" in "Help Button"
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option: Help Button Shaow

Then you can see the button and click to get the tips as below:
" Help x

'H" Double click to zoom in or out

# Drag the page corner to wview

(9) Share Button

If you want your flipbook viewers to send the link to their friends or clients, you can add a share button in
your flipbook for readers to send out your flipbook link immediately:
I Share Button

‘Share Button Shu:uyv
Email Subject Rear my fii...
Email Body fink}

When the viewers click the share buttonE, they will enter into the Email interface with the link of your
flipbook in the Email body.

(10) Home Button

You can add a home butt_onn to help reader to click and go to your website directly:
ElHome Button _
Home Button Visible Show
Page URL http: ffflipbuil. ..
Open Window Blank

(11) Auto Flip

s

N AT

el B R
Play Count -1

_ Autofipwhenstartup [fes
To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the Flip Interval
(seconds of staying on each page); the value of "Play Count" stands for the times of auto playing the eBook,

and "-1" stands for playing forever (after clicking the Auto Flip button “, the flipbooks will be flipped
by staying 3 seconds per page); if you want to auto start and flip the eBook after opening, just set "Auto flip
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when start up->Yes":

(12) Tool Bar on Top
Tcu:ul Bar on top TF'-I_E

(13) Page Number Box on Bottom

Page Numl:uer Eh::ux Cln B . | True

5. Initial Show (set in Float/ Spread Template)

You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just select
"Bookmark" or "Thumbnails" in this option:

I Initial Show | Thumbnails ﬂ

For Example, select "Thumbnails":

Then you will get flipbook shown with below initial interface:

6. Bookmark
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E.
"_l'l_ Aboul Fip wod 2
'] Product lnshue: k|
__E._E Bage-lippirg efock festures 5
] Quick. Sten L

L] briteifaces 3
_1 Luserns dogiaament n

'] How to Ordes 32
| Srappad 13

In "Design Setting" panel (only in Classical Template, in other templates, the colors will be adjusted
automatically based on your defined flash window color), you can set "Font color", "Background color",
"Background alpha" (refers to the background opacity, value interval: 0~1, "0" stands for the background is
totally transparent), "Always Show Bookmark->True/ False" and "Panel Position->Left/ Right".

In "Bookmark" panel, if you didn't check "Import bookmark" option in "Import EPUB " interface, or you
want to create new bookmarks for your flipbook, you can add bookmarks even sub-bookmarks here, click
"Add" icons and then input "Title" and "Page".

When click the bookmark button, it will popup the bookmark panel immediately, and click on those
bookmarks, it will jump to the defined page automatically.

7. Links

[

If you have check "Import links" option in "Import Office " interface, then you can define settings here,
choose "Mouse over color", "Link alpha" (refers to the link area opacity, value interval: 0~1, "0" stands for
the area is totally transparent), "Border color", "Border width" and "Open Window->Blank/ Self". The links
also can be clicked after zooming by setting "Enable after Zooming in->Enable".
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8. Language

|_Langusge |English |

You can set language for showing tools or tips in your created flipbook, and here is the specialized
instruction page for setting the "Language Option".

9. Security Settings

[ Security Settings Single Pas: ]

If you want to protect your flash books with passwords, you can click "..." icon to enter into "Flash Security
Config" interface: ‘

‘@ Flash Securty Config. ]

Mobe:
Sngha Password opton means that users need the password to view the fash book,

Exgude Frant Pages apbon is to set a page number, all latter pages can't be
wiewed without inputting password.

Security Type

Ho Security

I |
(AN
@ Singie Paseword: 173456
Protect Page Range
| & Al Pages

I Exdude Front Pages

| Ce ] o=

Select "Security Type->Single Password", and input passwords into the box (there is no restriction on
password format at present). You can also set "Protect Page Range" as "All Pages" or the latter pages after
a defined page number. (Tips: The program utilize RC4 algorithm to protect eBook pages, the eBook
content pages will show nothing without permission.)

10. Font
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Product features

Fomtcdor N
_ Button Font
.

. WindowFort
. Bookmark Fent Color |
Bookmark Font

License Agreements

Hrw to Order

If you want to change fonts of toolbar buttons, flash windows even bookmarks, you can set font types and
colors in Font Panel.

11. Google Analytics
G;aﬁgle Analytics ID

In the HTML output format, you can add statistics by using google analytics. You can get more information
about Google Analytics ID from http://www.google.com/analytics/ .

(Al apply Change |

At last, click icon to apply the settings.

IV. Language Options Interface

Click "Option->Flash Language", you will enter into the Language Settings interface as below shows:
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You can new or edit a language for the flash fiipping book.
The: Labled column below is the string that will be displayed in the flash.
Wy The language will be st in the flash template settings

e - - . —
Language Name: [Engish v) [# tewianguage| [ $peete | (B sovens.,| [ Galioed. |
Language Sethings |
Label Labled - [ B
First Button First
Next Page Button Next Page £
Last Button Last
Frevious Page Button Previous Page A '
Dowrioad Button Dowrioad
Prink Button Print
Searth Button Search
Bogk Mark Button Book Mark
Help Button Help |
Enable FulScreen Button  Enable FulScresn
Disable Fullsreen Button Disable FullScreen
| Graimd i Bt G i 2

Panel Description:

As the tips explaining, the "Labled" column lists the buttons and instructions on Flash books in defined
language, and the program provides you five different languages for you to use: English, Chinese Arabic,
French and Greek.

Language Name: Em "J

Arabic

You can also add other language for your own uses:

1. Click the button[ g Hew tanguage i_and define name for the new language:
(2] New Language p— |

New Languags |

Name: French

Copy From: | English -

L ] [ew]

Click "OK" to save the new language in the list;
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2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box, then click "Save
And Edit Next":

Language Settings
Next Page Button L
Last Butten Last i Edii Language ltem -
Frevious Page Button Previous P —————————
Dowrload Buttan Download || 53t Lengiage Strig |
Print Button Print
Saanch Buttan Sasarch Label 1 FirstButton
Bt Mark Button Beok Mark Y ]
reelo Button Felp Labeied:  Presménel
Enable FulSoreen Button Enabie Fuls
[ieabie Fulscreen Button  Desable Fult
| S O Bustbnes, smmdrn
[_&-vuwsdnum | | Cancel
] =

3. At last, you can get all Labels translated into your new language as the images shows:

Label Labled

First Button Premiére

Mext Page Button Page suivante
Last Button Derniére

Previous Page Button Page précédente
Download Button Télécharger

Print Button Irnprimer

Search Button Rechercher

Book Mark Button Réserver Mark
Help Button Aide

Enable Fullscreen Button Activer FullScreen
Disable FullScreen Button Désactiver FullScreen
S Tim Bt e Craumd

Delete
You can delete unwanted language:

Or save your edited new language file as XML or TXT file:
33 Load...
Load language file saving before for current using:
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V. Output Interface:

E‘I Cutput Option

| output |
Output type
- b
‘3 @ *.html f‘ﬁ T = exe
[¥] Also Make Mobile Version  Make output page-fipping eBook works on iPad, iPhone and Android mobile devices
Path
Output Folder: C:\Users\Administrator\Documents I Browse... | [ Open
File Mame: index Jhtml
Options
HTML Title: Microsoft Word - Documentl [ Advanced
[ Burn to CD
=0 i 10,G: PLDS  DVD-ROM DH-16055 VD15
| Make it automatically play the flipbook in CD
[ Cancel J I LConvert |
Output types:
1. HTML

9 son

This output type is for uploading created page-flipping ebook onto websites:

You can define HTML Title and other properties by clicking "Advanced" button:
Options

HTML Title: ‘demo ,Ja“ &dvanced]

Set Keywords, Description or even Script in the below interface:
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@-ﬁdwn::d Settings ﬁ

HTML Advanced Satings

HTML Meta Sattings
Titla: Flip Word Introducbon
Keywords:  corvert, ward, doc, fipbook, page-fioping, shock, flash, template, security

Descrighion: Pl word is & tood to convert Word fies to nicelpage-fippng eBok with ease,

Add Soripts
o B put soms Eracking
code much a5 Googie
fnalybcs here,
Reed dosed csarpt>tag
i -
2.ZIp
B e
@l

This output type is for compressing the created files into an integral ZIP package which can be sending out
as attachment directly. You can also define HTML Advanced Settings by clicking "Advanced"

e demo html

baok.st

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:

—_—

| demo.exe

You can also define Icon and Opening Window Size in Advanced Settings:
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o v
| Adh i
@ vansed Settings e |
Exe Advenced Setbings
Exe Window Info

Capbien:  Fip Word Introducton

Windew e Cobon

) Mawenged Custom Sae B0 |

You can even output Mobile Version at the same time:
i E_Alsc; Mallce.r\':lﬁilj-iiel\a'ersion l
After creating mobile versions, you just need to output all files online (including HTML, SWF, "files" and

"mobile" folders), then you can visit the flipbook page through your mobile browser.

Or even burn the output flipbook to CD:

CD Writer |0:1:0,G: PLDS  DVD-ROM DH-16D55 VD15

Disc title: |Page-Flipping eBook

[¥] Make it automatically play the fipbook in CD

After choosing output type, then check the option "Burn to CD", set "CD Writer", define "Disc title", at last

C t
click button to output flipbook in your defined type.

At Last
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With EPUB TO FLIPBOOK, you can easy create beautiful and professional page-
flipping eBooks within a few seconds.

Now, use the wonderful to produce your style stunning page-flipping eBooks.

For more information: http://www.flippagemaker.com/
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